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Why do we need to make things accessible? 

As a public sector body and an employer we have a legal obligation to make reasonable 

adjustments under the Equality Act 2010 to ensure equitable access.  

When we use the word ‘accessible’ in this context we are using it to describe whether a 

document, website, electronic survey (like smart survey or survey monkey) can be used 

by people of all abilities and disabilities. 

The Public Sector Bodies (Websites and Mobile Applications) (No. 2) Accessibility 

Regulations 2018 came into force on 23 September 2018. This says that public sector 

organisations must make their website or mobile app more accessible by making it 

‘perceivable, operable, understandable and robust’.  

The Equality and Human Rights Commission (EHRC) enforces the requirement to make 

public sector websites and mobile apps accessible (making them perceivable, operable, 

understandable, and robust). The Minister for the Cabinet Office is responsible for the 

monitoring and reporting on compliance. 

Organisations that do not meet the accessibility requirement or fail to provide a 

satisfactory response to a request to produce information in an accessible format, will be 

failing to make reasonable adjustments. This means they will be in breach of the Equality 

Act 2010. 

Documents published on public sector websites must meet accessibility standards. This 

is so they can be used by as many people as possible, including those with disabilities. It 

is important to make sure any new content or features that you publish meet accessibility 

standards. If they do not meet those standards, you will have to go back and fix things. 

Anyone who edits or uploads content on your organisations website or app has a 

responsibility to make content and features accessible. This means: 

• making sure any new PDFs or other documents they create are accessible 

• writing good link text 

• structuring content well 

• Publishing accessible images and videos 

• making sure new features work on assistive technologies 

This means that from 2018 we as an organisation had to ensure that all files and text 

content we share on our website, such as surveys, PDFs, PowerPoint presentations and 

http://www.legislation.gov.uk/uksi/2018/852/contents/made
http://www.legislation.gov.uk/uksi/2018/852/contents/made
https://www.gov.uk/guidance/accessibility-requirements-for-public-sector-websites-and-apps#how-the-accessibility-regulations-will-be-monitored-and-enforced
https://www.legislation.gov.uk/uksi/2018/852/regulation/9/made
https://www.gov.uk/guidance/accessibility-requirements-for-public-sector-websites-and-apps
https://www.gov.uk/guidance/how-to-publish-on-gov-uk/accessible-pdfs
https://www.gov.uk/guidance/content-design/links
https://www.gov.uk/guidance/content-design/writing-for-gov-uk#structuring-your-content
https://www.gov.uk/guidance/how-to-publish-on-gov-uk/images-and-videos
https://www.gov.uk/service-manual/technology/designing-for-different-browsers-and-devices#testing-with-assistive-technologies
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Excel comply with these regulations. There are several things that we need to do when 

generating a PDF from Microsoft Word to make it accessible – this guide outlines the 

main steps that need to be taken so please try and follow it closely when producing your 

documents. 

References: 

This guidance has been developed using best practice and resources including 

information from: Diverse Cymru, Abilitynet, Webaim, Plain English Campaign, Microsoft, 

Adobe, Accessibility and Usability at Penn State, Devon and Torbay Plain English Guide, 

UK Government Digital Service, RNIB, Mencap, British Dyslexia Association, Imperial 

College, UKAAF , Smart survey and JISC. 

If you need further advice, please see the accessibility information on MS Teams or your 

organisations intranet. Or you can contact your Equality, Engagement or 

Communications teams. 

  

https://abilitynet.org.uk/
https://webaim.org/
http://www.plainenglish.co.uk/
https://www.microsoft.com/en-gb/accessibility/windows?rtc=1&activetab=pivot_1%3aprimaryr2
https://www.adobe.com/accessibility/resources.html
https://accessibility.psu.edu/microsoftoffice/
https://www.gov.uk/government/publications/inclusive-communication/accessible-communication-formats
https://www.rnib.org.uk/
https://www.mencap.org.uk/
https://www.bdadyslexia.org.uk/advice/employers/creating-a-dyslexia-friendly-workplace/dyslexia-friendly-style-guide
https://www.ukaaf.org/
https://help.smartsurvey.co.uk/categories/design-and-manage?s=accessibility
mailto:calccg.equalityckw@nhs.net
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Section 1: Creating accessible content for documents. 

This section explains what you need to do to make a Microsoft Word document 

accessible using the formatting functions within Word 365. There is a quick reference 

section with hyperlinks at the beginning of the section with the essential information and 

then more detailed information for reference purposes. 

Quick reference section 

For creating accessible documents: 

✓ For documents 6 pages or longer, include a table of contents using the Table of 

Contents command (found in the References section of the toolbar).  

 
✓ Remember to insert page numbers so they can be used in the Table of Contents and 

users can easily navigate their way around a document.  

 
✓ Remember to set your alignment and spacing accessibly. Always align text to the left. 

Do not centre or justify text or use vertical text. Use a line space of at least 1.5 and 

character spacing of at least Before 0 and After 6. 

 
✓ Use the Heading Styles menu including Title, Heading 1, Heading 2, Heading 3 and 

Heading 4 to clearly layout and structure the document.  

 
✓ You will need to set your font and text size to Arial font size 12 pt minimum. Larger 

font sizes for headings or emphasis are fine. You may use variations of Arial e.g., 

Arial Bold. 

✓ Set font colour to ‘automatic’ instead of ‘black’. Blue is fine for hyperlinks. Nothing 

should be indicated by colour alone, anything that is indicated by colour needs to 

have a secondary way for it to be distinguished.  

✓ Avoid using light coloured text on a white background and dark coloured text on a 

dark background and avoid using text boxes with coloured backgrounds. 

 
✓ Avoid putting important information in headers and footers (other than page 

numbers). If you do use footnotes, put them in point size 12. 

 
✓ Use short sentences and paragraphs, average sentence length of 15 - 20 words. 
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✓ Write initialism or acronyms out in full the first time you use them, even if it is a 

commonly used term. E.g., first time you use “Integrated Care Board” (ICB)” and after 

this you can use ICB. 

 
✓ Avoid using italics or underlining. Bold is fine to use for emphasising or bringing 

attention to things e.g., for Headings, underlining fine for hyperlinks. When separating 

words with a forward slash (/) always include a space either side e.g., clear / large 

print rather than clear/large print.  

 
✓ Format bullet points and numbered lists by using the List Paragraph option in the 

Heading Styles menu.  

 
✓ Remember to use images illustrate your text and not convey new information without 

explanation.  

✓ When resizing an image, always do so proportionally. Never change the width or 

height without changing the other. This leads to images being squashed or stretched. 

Check that your image is not too small to be seen clearly or pixelated by being made 

too large. 

✓ Make sure there is a reasonable clear gap between an image and text, or the layout 

will look crowded. 

✓ Avoid fitting text around images. Placing images at the end of paragraphs allowing 

sufficient space between the text and the image, and “wrapping style” should be set 

as “In line with text”.  

✓ Avoid placing text over any background image, placing images in text boxes, or 

placing an image on top of another image. 

✓ Avoid inserting images of scanned documents containing text as the content will not 

be recognised by screen readers. If possible, fully replicate the content of the scan 

either in the document itself (replacing the need for the scan) or type it in the 

alternative text field. 

✓ Do not use the automatically generated alt text descriptions provided by MS Word. 

They are not helpful or accurate. 

 

✓ Alternative text (Alt Text) can be added by right clicking the image, clicking ‘edit Alt 

text’, and then enter appropriate alternative text in the field that appears in the Alt 

Text sidebar. If image is decorative, leave field blank and check Mark as decorative. 

https://webaim.org/techniques/word/word365mac#altText
https://webaim.org/techniques/word/word365mac#altText
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✓ Don’t type ‘Picture of’ or ‘Image of’ before your descriptive text and make your alt 

text as short as possible whilst still conveying the meaning of your image. If the 

content is substantial add this as text to the document rather than including it in alt 

text. 

✓ Tables should only be used to set out tabular data, not used to set the layout or 

style a page e.g., for an agenda or form.  

✓ Use the Insert Table command to create a table and do not insert a table as an 

image as this is not accessible. 

✓ Do not use split cells, merged cells, nested tables, or completely blank rows or 

columns. Keep text horizontal. 

✓ Use appropriate column headings that accurately explain in simple terms the 

content of each column. 

✓ If the table spans multiple pages, this header should be repeated by highlighting 

the row, right clicking it, going into ‘Table properties’ then ‘Row’ and checking the 

‘Repeat as header row at the top of each page. To make sure that rows do not 

split across pages, enter the table properties and uncheck ‘Allow row to break 

across pages. 

✓ Remember to add alt text to the table properties section 

✓ Information contained in text boxes is not accessible to some assistive software. 

Avoid using them wherever possible. You can highlight text with colour rather than 

using text boxes but be careful with colour choices and contrast, 

✓ The simplest way to make flow charts more accessible (apart from ensuring text is 

size 12 font black and colour contrast has been considered and accessible options 

chosen) is to save it as a picture using  the Snip and Sketch tool, remember to add 

alt text and include text above it detailing the process that it covers.  

✓ Make sure you add alt text to Graphs and Charts. Provide a summary of the chart 

in the text of your document. 

✓ If the chart, graph, or table have been formatted in excel keep this formatting. 

Do not turn them into an image. Reduce unnecessary complexity in your images 

where possible. Make sure your font style and size, colour etc are accessible. 

Make sure to provide context in the text in your document and refer to the graph or 

chart. 
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✓ When using hyperlinks avoid phrases like ‘click here’ and ‘visit this document’ and 

use descriptive text instead. Use meaningful text for hyperlinks; do not use the file 

address or path name. 

Example: of bad practice a): ‘If you would like more information, click this link.’ 

Example: of good practice b): ‘If you would like more information, go to the NHS 

website’ or you could use ‘The NHS website has more information.’ 

✓ If you need to share a full URL for example you are printing a document or its 

going onto a poster then you should reduce the URL size.  

E.g., nhs.uk or (www.nhs.uk/). 

✓ For a document that may be printed and accessed online you could use both 

examples b) and c). 

 
✓ Remember to check your document for accessibility you can do this by using the 

Check Accessibility function which you will find in the File or Review Section of 

your ribbon. This will highlight any accessibility-related problems, describe why 

you should fix them, and give you guidance on how to do so. 

Please note that the Checker may not identify all issues and it is important to 

always review your work yourself to find the issues hiding from the Accessibility 

Checker. 

✓ Save your document as a PDF to do this you will need to: 

1. Click File > Save As and choose where you want the file to be saved. 

2. In the Save As dialog box, choose PDF in the Save as type list. Then click 

More Options. 

3. Choose minimum size for publishing, then click Options  

4. Make sure the Document structure tags for accessibility check box is 

selected as in image below and then click OK. 

  

https://www.nhs.uk/
https://www.nhs.uk/
https://www.nhs.uk/
https://www.nhs.uk/
https://www.nhs.uk/
http://www.nhs.uk/
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More detailed information 

Headings 

Make sure that you use Heading styles including the Title, Heading 1, Heading 2, and 

Heading 3 etc. This clearly sets out the layout and structure of the document. This is 

important so that the bookmarks (when a PDF is generated) and table of contents 

function properly. 

 

The Title style should be used to set out the title of the document on the first page with 

the Table of Contents following it. Heading 1 should be used to denote the main sections 

of a document, whilst Heading 2 should be used to denote sub-sections and so on. 

These should be used in a logical, chronological order so that PDF viewers pick up the 

reading order correctly. If setting the Title on a front sheet, make sure you use line 

spacing to position where you want it to go rather than using the return key. 

Formatting Headings 

By formatting headings in a document, you are making sure that visually impaired people 

and people using software to help them read documents (assistive technology e.g., 

screen readers or text to speech readers) can navigate their way through your document. 

To create headings that screen-reader software will recognise, the text must be formatted 

using Microsoft's inbuilt 'Styles' menu, shown below: 

 

Using the styles menu will not only give us the visual effect we want but it also ‘tags’ the 

text as a heading which allows the assistive software to recognise it as such. It also 

enables you to create a table of contents if required. To create a heading, highlight the 

text, and choose the Heading Style you want from the Home tab in the Word Ribbon as 

shown below. 

 

https://support.microsoft.com/en-us/office/video-improve-accessibility-with-heading-styles-68f1eeff-6113-410f-8313-b5d382cc3be1
https://webaim.org/techniques/word/word365win#headings
https://webaim.org/techniques/word/word365win#headings
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The default style settings will be too small for an accessible document, but you can easily 

change the font settings. Right-click any of the styles and select ‘Modify’ and then change 

to the settings you need.  

Footers and Footnotes 

Avoid putting important information in headers and footers (other than page numbers) as 

screen-readers may not be set to read them. If you do use footnotes, put them in font 

size 12 so that they are readable. 

Styling text 

• Keep sentences and paragraphs short. Aim for an average sentence length of 15–

20 words. When you have finished writing, go through your document, and edit out 

any unnecessary words. 

• Use the title and introductory paragraph to say what the information is about, 

whom it is for, and why you are publishing it. 

• Avoid using abbreviations. Spell out words like "and" instead of using an 

ampersand (&) except when part of a company name e.g., "Holland & Barratt" or a 

standard abbreviation like A & E (which would not include an ampersand if written 

in full, i.e., Accident and Emergency). 

• Do not use ALL CAPITAL LETTERS except for recognised initialisms or acronyms 

such as NHS or ICB. 

When using an initialism or acronym for the first time, be sure to write it out in full, even if 

it is a commonly used term in your area of work. For example, the first time you would 

use “Integrated Care Board” and after this you can just use ICB. 

• Underlining can make text harder to read and can be mistaken for a hyperlink.  

• Italics also reduce readability and should be avoided, the main exception being 

legal case citations that are traditionally italicised.  

• Bold can be used for emphasis, but it should be used sparingly. 

• If you need to separate words with a forward slash (/) always include a space 

either side of it as this makes it easier to read e.g., clear / large print rather than 

clear/large print. 

• Write in direct language using everyday words. 

If you are copying text from another document to put into yours, make sure that you clear 

all formatting so that no styles are carried over from the original document. To do this you 



Page 12 of 45 

can use ‘Paste special’ and choose ‘Unformatted text’ when pasting content into your 

document, or you can paste it in as normal, select all the text by pressing ‘ctrl A’ and then 

clicking the eraser ‘Remove formatting’ button on the home pane of Microsoft Word. 

Fonts and Text size 

Fonts broadly fall into two categories ‘sans serif’ and ‘serif’. Serifs are semi-structural 

details or small decorative flourishes on the ends of some of the strokes that make up 

letters and symbols (Sans means without).  

You should use a ‘sans serif’ font e.g., Arial, Verdana, Trebuchet, or Tahoma whenever 

possible as these are generally considered easier to read on screen and in print because 

the characters are simpler and easier to read. Where possible limit the use of different 

fonts in a single document. 

Best practice advises using 14-point font as standard, but 12 is also acceptable.  

Do not use a size less than 12 in any part of a document, including footnotes. Large print 

can be anything above 16 point. If you are asked to provide large print you should ask 

the individual for their preferred font and size, and ensure your document still works when 

re-sized e.g., contents page matches actual pages in the text.  

Colour and Contrast 

Text colour 

Always set the font colour to ‘automatic’ instead of ‘black’. Some people with impairments 

use high contrast settings such as yellow text on a black background. If your font is set to 

‘black’, then it will appear as black regardless of a user’s settings. If the text is set to be 

‘automatic’, it will change according to each user’s preferences. Only use black or dark 

coloured text when printing documents unless otherwise requested.  

If creating a document with different coloured text such as a poster think about the 

colours you are using and consider whether they are going to be accessible, think about 

the contrast and consider options such as providing a plain text version or if you can 

convey the information in another format as well as the poster.  

There is more information and guidance in the colour guidance and resources section on 

page 17. 
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Setting the layout 

Instead of adding in multiple returns when creating a new page or moving text to a new 

page, page breaks or section breaks should be used wherever possible. Be careful 

however not to leave large spaces of empty page between text content as this can also 

make your document less accessible. 

To use the page break function as shown in the screenshot below, click after the text you 

want to remain on the current page, choosing ‘Insert’ on the top pane, ‘Pages’ and 

selecting ‘Page break’, any new content will now start on the following page. 

 

You can also choose ‘Layout’ on the top pane, ‘Breaks’ and then select ‘Page Breaks’ 

or ‘Section Breaks’.  

Alignment and Spacing 

Always align text to the left, do not centre or justify otherwise some screen readers will 

have difficulty finding the beginning of lines. Vertical text is not compatible with screen-

reader software. 

Text can be difficult to read if the lines are too close together. Use a line space of at least 

1.15 although 1.5 is preferable. The ‘Line and Paragraph Spacing’ button can be found 

on the ‘Paragraph’ panel of the ‘Home’ ribbon on Word. Spaces can also be added 

before or after paragraphs via the ‘Page Layout’ tab.  

Whilst you are setting your line spacing remember to set your character spacing as well 

as well which should as a minimum be set to Before 0 pt. and After 6 pt.  
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As shown in the screen shot below choose Line and Paragraph Spacing and pick 1.5 

line spacing. 

 

Then choose Line Spacing Options as shown in the screenshot below and amend your 

spacing to Before 0 pt. and After 6 pt.  

 

Never use the space bar to create a line break or indents. If you need to indent text, use 

the ‘tab’ key. This will ensure consistent indents throughout your document. You can also 

set your line spacing, font style and size using the Paragraph Spacing option in the 

Design Tab and choosing the ‘Relaxed’ option as shown in the image below which 
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would meet the minimum standards or set them yourself in the Custom Paragraph 

Spacing option and make these your default settings for your document 

You can also change the spacing between text to increase accessibility however be 

mindful that too much space between words in a sentence can make it harder to read.  

Bullets Points and Numbered Lists 

Bullet points and numbered lists are a great way to pass on information. They can be 

understood immediately and are often much simpler than a block of text. Review your 

work to see where these could be included.  

Bullet points and numbered lists can be read by screen readers, but make sure you 

introduce them with a descriptive sentence rather than rely on visual layout to infer 

meaning. Make use of the List paragraph option in the Heading Styles menu this ensures 

that the list is formatted appropriately. 

Blank Lines and Hidden Formatting 

Even content that you cannot see maybe read out loud or ignored by screen-readers 

such as spacing or punctuation and this can make documents confusing for the user. 

Paragraph Spacing and Page Breaks should be used instead of returns to create gaps 

between sections of text.  

Use the Show / Hide ¶ button, found on the ‘Paragraph’ tab of the ‘Home’ ribbon, to 

reveal the hidden formatting in your document and delete all unnecessary spaces, 

returns etc. 

Creating a table of contents 

This is advised for documents that are 6 pages or longer, however is often a good idea 

for shorter documents too so that they can be easier to understand. If heading styles 

have been applied properly, click ‘References’ in the control panel on Microsoft Word, 

then choose ‘Table of Contents – Automatic Table 1’. 

As shown in the screenshot on the next page the table of contents can also be updated 

by clicking ‘Update Table’ and then ‘Update Entire Table’ and then clicking OK. This will 

refresh any changes made to the headings and page numbers. When the file has been 

converted to a PDF, the contents table can be clicked taking users directly to the linked 

section. 

https://support.microsoft.com/en-us/office/change-the-spaces-between-text-e9b96011-1c42-45c0-ad8f-e8a6e4a33462#:~:text=Select%20the%20text%20that%20you,want%20in%20the%20By%20box.
https://webaim.org/techniques/word/word365win#lists
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Page numbering 

To go with the table of contents you need to enable page numbers so that users can 

easily navigate their way around a document. You can set page numbers to appear in the 

document footer in the middle or right side of the page, navigate to the ‘Insert’ tab, select 

‘Page Numbers’ and choose ‘Bottom of page’ which is shown in the screenshot below. 

 

To make your page numbers more accessible you could use the ‘X of Y’ option as 

shown in the screenshot below. Navigate to the ‘Insert’ tab, select ‘Page Numbers’ and 

choose ‘Bottom of page’ and then choose ‘Page X of Y’. This would then for example 

read as Page 1 of 10 (or however many pages there are in your document and 

automatically update) This helps the reader not to lose track of their progress in a 

document. As illustrated in the screenshot on the next page. 
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Images 

How to use images 

Images should only be used to illustrate your text and not convey new information without 

explanation.  

• When resizing an image, always do so proportionally. Never change the 

width or height without changing the other. This leads to images being 

squashed or stretched. 

• Also be sure that your image is not too small to be seen clearly or pixelated 

by being made too large. 

• Ensure there is a reasonable clear gap between an image and text, or the 

layout will look crowded. 

Using images in a document can help convey complex information. The use of 

appropriate images can also often help readers with dyslexia and learning difficulties to 

follow meaning. 

However, images placed in a random way can interrupt the flow of the text and make it 

even harder to follow, so avoid fitting text around images. Instead consider placing 

images at the end of paragraphs and allow sufficient space between the text and the 

image.  

To ensure the accessibility of non-text elements, the “wrapping style” should be set as “In 

line with text”. You should also avoid placing text over any background image, placing 

images in text boxes, or placing an image on top of another image. 
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Alt Text for Images 

Do not use the automatically generated alt text descriptions provided by MS Word. They 

are not helpful or accurate. 

Remember: to make sure alternative text is included for any images, scans, or other 

graphics. All images included in the PDF must have accurate alternative text (unless they 

are for decorative purposes) set for them so that anyone using screen readers can still 

fully understand the document. This applies to all images including charts, tables, scans, 

or graphics unless the image is purely decorative and the only purpose it serves is to 

improve the visual appearance of the document, then alt text is not required. 

Alt text can be added by right clicking the image, clicking ‘edit Alt text’, and then enter 

appropriate alternative text in the field that appears in the Alt Text sidebar. If the image is 

decorative, leave the field blank and check Mark as decorative. 

You do not need to type in ‘Picture of’ or ‘Image of’ before your descriptive text as the 

screen reader will automatically recognise that an image is present.  

Make your alt text as short as possible whilst still conveying the meaning of your image. 

This may not always be possible where images of tables or charts are used, and the 

information cannot be conveyed in limited text. If the content is substantial add this as 

text to the document rather than including it in alt text. 

Alt text must be meaningful not just a literal description of the image but also the context 

and purpose of the image. Think about why you have you used the image, what value is 

it bringing to the document and how does it support or enhance the meaning of the text.  

Avoid inserting images of scanned documents containing text as the content will not be 

recognised by screen readers. If possible, you should fully replicate the content of the 

scan either in the document itself (replacing the need for the scan) or type it in the 

alternative text field. 

Webaim has further useful guidance and information on using Alt text and Penn State 

University’s Accessibility resources provides helpful guidance on alt text use. 

Using colours with high levels of contrast 

If you are designing a graphic or diagram, you should use a colour scheme with high 

levels of contrast so that the visually impaired are still able to understand the content. 

This means avoiding using light coloured text on a white background and dark coloured 

https://webaim.org/techniques/word/word365mac#altText
https://webaim.org/techniques/alttext/
https://accessibility.psu.edu/images/alttext/
https://accessibility.psu.edu/images/alttext/
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text on a dark background. Using text boxes with coloured backgrounds is also bad 

practice in accessibility terms and should be avoided. 

Examples of colour contrast: 

This is good.  This is bad   

Remember: Nothing should be indicated by colour alone, anything that is indicated by 

colour needs to have a secondary way for it to be distinguished, for example: the RAG 

rating (Red Amber Green) is often used in action plans where the colours are used to 

signify a project’s progress and whether it is meeting its goals. 

This is okay for people who can see these colours but excludes those who can’t so is not 

accessible. An easy example is if you were to use grayscale to view an action plan which 

used the RAG rating method or printed it out not using a colour printer, you would not be 

able to tell what each shade of grey signified because the information is provided through 

colour alone. 

Text should be added along with the colour to convey the same information e.g., if green 

means completed then add completed rather than just adding the colour. And check that 

the text can be seen against the colour clearly if not use a paler shade of your chosen 

colour for your background colour. As shown in the example below. 

Achieved / Complete 

In progress 

Not in progress 

  

This is very bad. 
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Colour guidance and resources 

The UK Civil Service accessibility blog on ‘Colour contrast why does it matter?’ provides 

some more useful information on this topic. The RNIB has produced guidance on ‘How to 

choose colour and contrast for printed materials that benefits people with sight problems’. 

Penn State University has guidance and practical examples of how to produce accessible 

content using contrast, luminosity and brightness and other aspects of colour in 

documents and on web pages. 

Backgrounds 

Any background that has text over it should be a single colour, without pattern or texture. 

Ideally, ‘no colour’ should be selected so that users’ alternative settings can be used. 

Text on top of images can be difficult to read and should only be used when there is a 

consistent high contrast level between text and background. 

Text wrapping and captions 

Text wrapping: Avoid having text too close and overlapping images as this can make it 

hard to read for the visually impaired. Best practice recommends setting your text wrap to 

allow 6 mm spacing by using the ‘More layout’ option in the text wrap drop down. 

To ensure the accessibility of non-text elements, the “wrapping style” should be set as “In 

line with text”. 

1. Select the image/text box and right click inside the image. As shown in the image 

below an icon in a small box will appear at the right side of the image. This is the layout 

option. 

 

2. Click on the icon and a menu will appear called Layout Options. From this menu select 

In line with Text as illustrated in the image below. 

https://accessibility.blog.gov.uk/2016/06/17/colour-contrast-why-does-it-matter
http://scdg.org.uk/wp-content/uploads/2019/02/Colour-information-with-header-sheet-2.pdf
http://scdg.org.uk/wp-content/uploads/2019/02/Colour-information-with-header-sheet-2.pdf
https://accessibility.psu.edu/legibility/contrast/
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Captions: If you are using captions for images in your document, ensure that they are at 

least 12 pt in size and that the caption aligns correctly with the image and is reasonably 

close to the image. Captions are more useful than alt text especially for tables. 

Making tables accessible 

Tables should only be used to set out tabular data, not used to set the layout or style a 

page e.g., for an agenda or form. This is because the formatting used means that 

assistive software like screen readers or text to speech readers may not be able to 

access the text. 

Use the Insert Table command to create a table and do not insert a table as an image 

as this is not accessible. All tables should have appropriate column headings that 

accurately explain in simple terms the content of each column.  

Keep the text direction in tables horizontal, vertical text is difficult to read and 

inaccessible to screen-readers.  

Screen readers use header information to identify rows and columns. Ensure that tables 

do not contain split cells, merged cells, nested tables, or completely blank rows or 

columns. Screen readers keep track of their location in a table by counting table cells, so 

split cells, merged cells, and nested tables make the screen reader software lose its 

place. To add table headers: 

1. Left click inside the table. and the Table Design tab should appear in the top 

pane above the Styles section. 

2. Go to Table Design If the top row of the table contains headers for each 

column (most tables do), make sure the Header Row checkbox is checked. 

3. If the first column of the table contains headers for each row, check the First 

Column checkbox 
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In the Table Styles section, select a style where the table headers are clearly identified 

visually. Make sure the style has good contrast. 

If the table spans multiple pages, this header should be repeated by highlighting the row, 

right clicking it, going into ‘Table properties’ then ‘Row’ and checking the ‘Repeat as 

header row at the top of each page. To make sure that rows do not split across pages, 

enter the table properties and uncheck ‘Allow row to break across pages. 

Make sure you have remembered to included Alt text in your table properties to help 

people who cannot see the screen to understand what is important in images and other 

visuals. Give a brief description of the purpose of the table and content: e.g., Table 

showing the number of people attending the clinic from Monday to Friday by age group. 

You can do this by right clicking your table going into ‘Table properties’ then ‘Alt text’ 

then enter your text in the alt text description field. 

Where possible use the caption function for tables and images it makes it easier for 

people to locate specific information for example in a meeting particularly if you have 

more than one table or image on a page. 

1. To insert a caption right click a table and then click the insert caption option in the 

menu 

 

2. Insert your title and click ok. 

 

3.  Check that the text is formatted accessibly e.g., size 12 font, black text and not 

italics. 

 

Text Boxes and Flow charts 

Text boxes: Information contained in text boxes is not accessible to some assistive 

software. So please avoid using them wherever possible. You can highlight text using 

colour rather than a text box but need to be mindful of colour contrast issues. 

Flow charts: The simplest way to make flow chart more (accessible apart from ensuring 

text is size 12 font black and colour contrast has been considered and accessible options 

chosen) is to save it as a picture, remember to add alt text and include text above it 

detailing the process that it covers.  



Page 23 of 45 

Click the chart that you want to save as a picture. Choose Copy from the ribbon or press 

CTRL+C on your keyboard. Switch to the application you want to copy the chart to. If 

you're saving as a separate image file open your favourite graphics editor, such as 

Microsoft Paint. 

Another option is to use the Snip & Sketch tool:  

Take a screenshot. 

▪ Press the Start button and enter Snip & Sketch in the search field.  

▪ Press the New button to start snipping with the snipping bar.  

The snipping bar allows you to capture the following types of snips:  

▪ Rectangular snip. Drag the cursor around an object to form a rectangle. 

▪ Free-form snip. Draw a free-form shape around an object.  

▪ Full-screen snip. Capture the entire screen. 

Once you snip an area of your screen — the snipped image is added to your clipboard, 

and you can paste it immediately into another app. A screen prompt will also allow you to 

annotate, save or share it using the Snip & Sketch app. 

Once you have pasted your flow chart into your document then add appropriate alt text 

as you would to any image, you will need to provide some text above or below the flow 

chart detailing the process outlined in the flow chart explaining each step. 

 

Making Charts and graphs accessible 

Not all charts and graphs are accessible to everyone, think carefully about your audience 

and whether the graph or chart being used is the most accessible option that you could 

be using. 

Remember to: 

1. Make sure you add alt text. 

2. Provide a summary of the chart in the text of your document. 

3. If the chart, graph, or table have been formatted in excel keep this formatting. 

Do not turn them into an image. 

https://support.microsoft.com/en-us/windows/how-to-take-and-annotate-screenshots-on-windows-10-ca08e124-cc30-2579-3e55-6db63e36fbb9
https://accessibility.psu.edu/images/flowcharts/
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4. Reduce unnecessary complexity in your images where possible. Make sure your 

font style and size, colour etc are accessible. 

5. Make sure to provide context in the text in your document and refer to the graph or 

chart.  

Making sure hyperlinks are accessible.  

Whether linking to another document, website or file, the link should be able to stand-

alone. This means avoiding phrases like ‘click here’ and ‘visit this document’ and using 

descriptive text instead. Some assistive software lists the links in a document so the link 

itself must be self-explanatory without using any additional text. Use meaningful text for 

hyperlinks; do not use the file address or path name. 

Examples: 

• Bad practice a): ‘If you would like more information, click this link.’ 

• Good practice b): ‘If you would like more information, go to the NHS website or 

the NHS website has more information. 

If you need to share a full URL for example you are printing a document or its going onto 

a poster then you should reduce the URL size. Most people are unlikely to put a full URL 

address into a search engine if they are looking for something, and it is not very 

accessible or easy remember so you would not use: https://www.nhs.uk. 

Good Practice: c) Use instead: nhs.uk or (www.nhs.uk)For a document that may be 

printed and accessed online you could use both examples b) and c). 

Checking your document for accessibility  

Readability and Word Accessibility Checker 

 

Make use of the readability statistics tool. This is a function in Microsoft Word which gives 

your document a score based on the average number of syllables per word and words 

per sentence. When Word finishes checking the spelling and grammar and errors 

corrected, you can choose to display information about the reading level of the 

document, including readability scores according to the Flesch-Kincaid Grade Level test 

and Flesch Reading Ease test. 

The Flesch Reading Ease score rates text on a 100-point scale; the higher the score, the 

easier it is to understand the document. For most standard documents, you should aim 

https://www.nhs.uk/
https://www.nhs.uk/
https://www.nhs.uk/
https://www.nhs.uk/
https://www.nhs.uk/
https://www.nhs.uk/
https://support.microsoft.com/en-us/topic/get-your-document-s-readability-and-level-statistics-85b4969e-e80a-4777-8dd3-f7fc3c8b3fd2
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for a score of 60 to 70. The Flesch-Kincaid Grade Level score rates text on a United 

States grade school level. For most standard documents, aim for a score of 7 to 8. 

1. Go to File > Options. 

2. Select Proofing. 

3. Under When correcting spelling and grammar in Word, make sure the Check 

grammar with spelling check box is selected. 

4. Select Show readability statistics. 

After you enable this feature, open a file that you want to check, and check the spelling 

by pressing F7 or going to Review > Spelling & Grammar. When Word finishes 

checking the spelling and grammar, it displays information about the reading level of the 

document 

Important: You must correct or ignore all errors found in the document before the 

readability statistics will display. 

Word Accessibility Checker 

You will need to check the accessibility of your document in ‘Word’ by using its built-in 

accessibility checker. This will highlight any accessibility-related problems with your 

document, describe why you should fix them, and give you guidance on how to do so. 

1. On the ribbon, select the Review tab. Then select Check Accessibility. 

2. Review your results which appear at the right side of the screen. You will see a list 

of errors, warnings, and tips with how-to-fix recommendations for each. See Rules 

for the Accessibility Checker for more information. 

You can also select File > Info > Check for Issues > Check Accessibility 

To be notified of accessibility issues in your document as you continue working on it, tick 

the Keep accessibility checker running while I work check box. 

To easily address accessibility errors and warnings, select an issue to open the 

Recommended Actions list. You can apply a one-click fix by selecting an action or select 

the arrow button next to an action for more options. 

The checker's Inspection Results classifies accessibility issues into four categories: 

https://support.microsoft.com/en-us/topic/check-spelling-and-grammar-in-office-5cdeced7-d81d-47de-9096-efd0ee909227
https://webaim.org/techniques/word/word365win#checker
https://webaim.org/techniques/word/word365win#checker
https://support.microsoft.com/en-us/topic/rules-for-the-accessibility-checker-651e08f2-0fc3-4e10-aaca-74b4a67101c1
https://support.microsoft.com/en-us/topic/rules-for-the-accessibility-checker-651e08f2-0fc3-4e10-aaca-74b4a67101c1
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• Errors: content that makes a document very difficult or impossible for people with 

disabilities to access. Example: an image with no alt text. 

• Warnings: content that in most—but not all—cases make the document difficult 

for people with disabilities to access. Example: a link with text that is not 

descriptive of its function. 

• Tips: content that people with disabilities can access, but that might be better 

organized or presented. Example: skipping from a first level heading to a third-

level heading. 

• Intelligent Services. Content that is automatically made accessible by the 

Accessibility Checker programme, which you should review for accuracy and 

context. This usually when it suggests Alt text DO NOT USE its suggested Alt text 

or it may suggest spelling, grammar, or punctuation. 

Clicking an item in the results highlights the corresponding item in the document and 

displays the Additional Information section: 

• Why Fix explains why the issue impacts accessibility. 

• How to Fix: suggestions for repairing the issue 

Webaim have developed some information that will support you to address the issues 

raised.  

What the Checker cannot check for 

Although the Accessibility Checker catches most types of accessibility issues, there are 

some issues it is not able to detect. For example:  

• it does not tell you if you have used italics, capital letters or ampersands, or 

underlining acronyms when you should not do so, 

• nor will it tell you if the colours used in diagrams or documents are not appropriate 

although it can now tell you if your text colour contrast is hard to read. 

• It will not determine if you are using a table layout as a design feature for a text 

document like an agenda or report rather than for data. Or if you have not got the 

correct line spacing, character spacing or spaces between paragraphs.  

• It no longer checks for extra characters and spaces.  

• It no longer checks for alt text on tables. 

https://webaim.org/resources/evaloffice/
https://webaim.org/resources/evaloffice/
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That is why it is important to always review your work yourself to find the issues hiding 

from the Accessibility Checker. 

If you use a screen reader and need to use the Accessibility Checker, Microsoft has 

useful guidance on how to use the accessibility checker. 

Publishing a document 

When publishing a document onto the Integrated Care Board website you will need to 

think about what needs to be published and what could be put as webpage text content. 

Please discuss your options with your communications team colleagues. 

Creating your PDF  

Saving your document as a PDF in MS Office allows you to create tagged PDF files 

without installing Adobe Acrobat. Tags define the intended reading order of the content 

on each page for screen reader software. The software relies on these tags to present 

text in a way that makes sense when someone is hearing the text read out loud. The tags 

allow a screen reader to interpret page elements such as headings, sidebars, tables, and 

multi-column text. The tagging process is not as clean as with the Adobe add-in, so it is 

recommend using Adobe Acrobat or Acrobat Pro if you have it. 

To save a document as a PDF in Word 365 

1. As shown in the image below Click File > Save As and choose where you want 

the file to be saved. 

 

 

2. In the Save As dialog box, choose PDF in the Save as type list. As shown in the 

image below. Then click More Options. 

https://support.microsoft.com/en-us/topic/use-a-screen-reader-with-the-accessibility-checker-4be102bf-8bb1-47f6-a5b8-3e055aa5b342#PickTab=Windows
https://webaim.org/techniques/acrobat/converting#acrobat
https://support.microsoft.com/en-us/topic/create-accessible-pdfs-064625e0-56ea-4e16-ad71-3aa33bb4b7ed
https://support.microsoft.com/en-us/topic/create-accessible-pdfs-064625e0-56ea-4e16-ad71-3aa33bb4b7ed
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3. Choose minimum size for publishing, then click Options as shown below. 

 

4. Make sure the Document structure tags for accessibility check box is selected 

as in image below and then click OK. As shown in the image on the following 

page: 
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Section 2: Accessibility and PowerPoint  

This section includes best practice from Microsoft, Webaim, Michigan State University 

and Penn State Accessibility and Usability resources. 

Slide Layouts and Reading Order 

The most important part of PowerPoint accessibility is the use of slide "layouts." Used 

correctly, these will ensure information on the slides have the correct heading structure 

and reading order. Most slide layouts include a slide "title," usually at the top of the slide. 

They also contain one or more "placeholder" areas where you add content like lists, 

images, and tables to each slide. The title will be presented as a heading to screen 

reader users and will be the first thing read on each slide. If each slide has a descriptive 

title, this will make it much easier for screen reader users to read and navigate the 

presentation. 

Webaim has further information on how to change slide layouts and how to create slide 

master which allows you to create accessible layouts that meet the needs of the 

presentation while maintaining a proper heading structure and reading order. 

Slide Reading Order 

There may be times when you need to add content to a slide when it would be 

impractical to create a new slide layout. By default, a screen reader will read the slide title 

first, followed by other content in elements defined in the slide layout. Then it will read 

any additional content on the side in the order it was added to the slide. If you add 

content with this principle in mind, it should be presented to screen reader users in a 

logical order. 

You can check or change this reading order by selecting Home > Arrange > Selection 

Pane. The Selection Pane will appear in the right-hand sidebar. See screen shot below: 

 

https://webaim.org/techniques/powerpoint/#layouts
https://webaim.org/techniques/powerpoint/#layouts
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The pane will show every object on the slide. Highlighting an object in the pane will also 

highlight it in the slide. The reading order for the elements in this page is bottom to top. 

The first object on the slide will be read first. If another object is added to the page on top 

of the first object, it will be read next by a screen reader (and will also cover the first 

object visually). To reorder an item, simply click and drag. PowerPoint for Windows also 

has up / down arrow buttons that can be used to reorder items. 

Alternative Text for Images 

PowerPoint presentations usually include images which will need alternative text (Alt text) 

adding to them. To add alternative text to an image in PowerPoint: 

1. Right-click on the image and select Edit Alt text, then enter appropriate 

alternative text in the field that appears in the Alt Text sidebar. 

2. If the image is decorative, leave the field blank and check Mark as decorative 

Do not select the "Generate a description for me" button. The quality of the automatically 

generated descriptions is usually very poor, and a description of an image is often not the 

same as alternative text. 

Tables 

Most screen readers will not identify table headers in PowerPoint however to make them 

more accessible. You will need to mark the first row of a table as a table header by using 

the table formatting options in the ribbon and checking Header Row for each table. 

Designating a Header Row can trigger a change in the table appearance. It is important 

that the formatting of each cell contains sufficient colour contrast. Note that additional 

options for banded rows/columns are compatible with screen readers and can be useful 

for sighted users. However, contrast should be checked if the cells are coloured. 

Hyperlinks 

PowerPoint automatically creates a hyperlink when a user pastes a full URL onto a slide 

and presses Enter or Space. Raw URLs may not make sense to screen reader users or 

others, so make the link text descriptive as you would for a Word document. The Making 

sure hyperlinks accessible section of this guidance on Page 22 has more helpful 

information on this topic. 

https://accessibility.psu.edu/microsoftoffice/microsofttableheaders/
https://accessibility.psu.edu/microsoftoffice/microsofttableheaders/
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Remember if you are creating a presentation that is intended to be displayed both 

electronically and in print, you may want to include the URL and a description in the link 

text. For example, the nhs.uk ‘Live well’ web page has advice, tips and tools to help you 

make the best choices about your health and wellbeing. (nhs.uk/live-well) 

Checking Accessibility  

PowerPoint includes a tool that will identify many common accessibility issues. To run the 

accessibility checker in Windows as shown below, select File > Info. Select the Check 

for Issues button and choose Check Accessibility. 

 

You can also start the accessibility checker by selecting the Review tab in the 

PowerPoint ribbon, then choosing Check Accessibility. The Accessibility Checker 

sidebar will appear to the right. 

The checker as shown on the following page (pg. 31) presents accessibility errors (e.g., 

images with no alternative text), warnings (e.g., unclear link text) and tips (e.g., check 

slide reading order for slides with custom content). Selecting an item in the report will 

highlight the issue within the slide. Information about the issue, and instructions on how 

to repair it, will also appear at the bottom of the sidebar. When the issue is addressed, it 

will disappear from the report automatically. 

https://www.nhs.uk/live-well/
https://www.nhs.uk/live-well/
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Other Accessibility Principles 

• Make sure text is not too small, especially if the presentation will be viewed 

remotely e.g., on Microsoft teams or Zoom. Use reader view when presenting 

online. 

• Do not use colour as the only way to convey information. 

• Transitions and animations should not be used and do not use moving images 

behind text. 

• Use clear and simple language. If you have embedded video, ensure the video is 

captioned and if you have embedded audio, include a transcript. 

• If you are presenting do not assume everyone can see the text or images, read 

the relevant text out. 

Microsoft also provide guidance on how to ‘Make your PowerPoint presentations 

accessible to people with disabilities’ 

Converting PowerPoint to PDF 

PowerPoint is effective for face-to-face presentations, but it is not always the best format 

for content on the web. The file can be large, and users must either have Microsoft Office 

or a plugin to view the file. For some users PDF maybe a better format to present 

PowerPoint presentations online however this is only if the appropriate accessibility 

ttps://support.microsoft.com/en-us/topic/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25
ttps://support.microsoft.com/en-us/topic/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25


Page 33 of 45 

aspects have been addressed. It may be more accessible to put the content from the 

PowerPoint presentation into an accessibly formatted word document and then save as a 

PDF. 

Section 3: Accessibility and Excel: Top tips and Publishing 

This section shares best practice from the RNIB, Penn State Accessibility and Usability, 

Michigan University, Webaim and Microsoft. 

Accessibility top tips for excel  

• Break down complex data sets into logical tables ideally with their own 

worksheets. New tables should be created on separate worksheets to aid 

navigation and understanding.  

• Reserve the first worksheet for a contents or index page.  

• Use Clear Print guidelines for text and data.  

• Include a title before any set of data in a spreadsheet. This title can be in the row 

above the first row, preferably in cell A1.  

• Put some text into cell A1. Preferably this should be the title of the data set, but if 

that is not possible, it should information about the structure and location of data, 

even if the colour is set to white. 

• Insert all text and data within a logical path that a keyboard only user would take. 

Usually, keyboard users will navigate down from cell A1 until the table is reached.  

• Empty cells within a table should be marked as such with a minus sign, a zero or 

N/A for not applicable as appropriate.  

• Adjust cell height and width to ensure all text that you want to appear is visible in 

your spreadsheet.  

• Add text descriptions and Alt text to charts and graphics.  

• Avoid using visual devices such as colour, shading, patterns, and borders to divide 

up data regions.  

• Avoid merging data or header cells. Merged cells cause navigation problems and 

will not be read correctly if they contain row or column headers. 

• Avoid using blank cells for formatting purposes. It is generally better to use other 

formatting tools such as adjusting column width or height. 

• Always save your spreadsheet with the focus on cell A1 unless you want to draw 

attention to a specific cell. 

http://www.psncorp.com/Downloads/RNIB_Clear_Print_Guidelines.pdf
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• Make sure all data rows and columns are labelled as in a data table. Use white 

text to include headers that might be distracting to sighted users 

• A table can also be marked as a named region to enable column and row headers 

to be read out optimally in screen readers. 

• Add an “End of Table” message in the row after the last row of a data table row. 

The text can be in white. 

Named Regions and Header Names 

Using the Names feature, it is possible to name a range of cells in such a way that 

header cells are spoken along with the value of the cell. This allows a person using a 

screen reader to understand the structure of a table more clearly. 

1. Input data into a range of cells such that each column and row has a label and 

there are no merged cells. 

2. Move your cursor to the top left cell of the range (e.g., cell A2). This should be a 

column header. 

Note: You don’t need to highlight the entire range. 

3. In the Formulas tab, select Define Name (tag icon). 

4. For the Name field input a name with the following template: 

Title<RegionName>..<rightcell>. For instance, for the table above, the name 

would be TitleSP16Grades..F5. 

Note: Names not following this template do not facilitate screen reader access. 

5. Click OK to set the name. The region Name has been set for a screen reader. 

Note: The Name is displayed in the formula bar when the cursor is in the top most 

shell other than that there is no visible change on the spreadsheet. 

Chart Wizard 

If you are using the Chart Wizard: 

1. Add Alt Text for any inserted chart, object or image used in Excel. 

2. Use the formatting options in line charts to create different types of dotted lines to 

facilitate legibility for colour blind users. 

3. Avoid using the yellow and bright teal lines; use formatting options to change it to 

a darker colour. 

https://accessibility.psu.edu/microsoftoffice/microsoftalttags
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4. Ensure that charts are legible are grayscale (black and white). 

5. Add a text key for bar charts or change the default colours to a colour safe palette. 

Essential steps for publishing 

It is essential to embed certain formatting and structure within an Excel spreadsheet so 

that assistive technology can follow the structure clearly and provide the information in a 

logical order to the disabled user. Proper structure also ensures that if the Excel file is 

converted to a PDF, it will continue to be accessible. The basic steps are provided below 

for Excel 2010 and above for PCs.  

1. Images and Visuals: Alt text, or a short description, helps people who cannot see 

the screen to understand what is important in images and other visuals. Provide alt 

text for each image, PivotChart, shape, SmartArt graphic, and table.  

2. Hyperlinks: Use link text that has meaning, such as “instructions for making an 

accessible Excel spreadsheet,” instead of “click here” or “learn more.” People who 

use screen readers sometimes scan a list of links, so links should convey clear 

and accurate information about the destination.  

3. Tables: Use a simple table structure and add column header information. Screen 

readers use header information to identify rows and columns. Ensure that tables 

do not contain split cells, merged cells, nested tables, or completely blank rows or 

columns. Screen readers keep track of their location in a table by counting table 

cells, so split cells, merged cells, and nested tables make the screen reader 

software lose its place.  

4. Tabs: Give all sheet tabs unique names and remove blank sheets.  

5. Sections: Cell sections are essentially shortcuts that a screen reader user can 

use. Providing the sections with an appropriate title allows screen reader users to 

quickly identify the purpose of the section. Select a range of cells, click "Formulas”, 

and then select "Define Name." Enter an appropriate title for the section and 

define the scope. The name field does not allow spaces.  

6. Check: Test your Excel spreadsheet for accessibility. Go to File, Info, Check for 

Issues, and Check Accessibility. You can also do this by going to the Review tab 

on the Excel ribbon and choosing Check Accessibility. 

7. Convert: Convert your accessible Excel spreadsheet into an accessible PDF: Go 

to File and Save as PDF  

https://support.microsoft.com/en-us/topic/create-accessible-pdfs-064625e0-56ea-4e16-ad71-3aa33bb4b7ed
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For further information the RNIB has a guide to creating accessible spreadsheets , there 

is the Michigan University Tutorial , Glasgow university guide to making excel accessible 

, NHS Scotland Guide to making excel accessible ( excel 2013) 

Useful practical guides to show how to make excel more accessible: 

• Microsoft Make your Excel documents accessible to people with disabilities 

• Penn State Accessibility and Usability Excel Tips 

• Microsoft Excel 2019: New! Excel 2019 Check Accessibility One Click 

• Creating an accessible excel spreadsheet part 1 

• Creating an accessible excel spreadsheet part 2 

• Creating accessible excel forms part 2 

• Creating accessible excel forms part one 

• Microsoft Create more accessible Excel workbooks  

Further accessibility information and resources 

• Worcester University Guide_to_making_a_document_accessible.pdf 

• RNIB guide to accessible excel spreadsheets 

• Excel accessibility resources 

• Webaim resources to support accessibility 

• UK government basic accessibility check 

• Penn State Accessibility and Usability: Microsoft Office 

• Abilitynet Creating Accessible Documents 

• Kent University Accessible Documents Guide 

Section 4: Creating Accessible Webpage content 

According to the Government Digital Service in their ‘Content design: planning, writing 

and managing content guide’ it’s important to remember if you are creating content for a 

webpage that: 

• People read differently on the web than they do on paper. This means that the 

best approach when writing for the web is different from writing for print. 

https://www.rnib.org.uk/sites/default/files/Creating%20accessible%20Excel%20spreadsheets.docx
https://webaccess.msu.edu/Tutorials/excel.html
https://www.gla.ac.uk/media/Media_736358_smxx.docx
https://www.gla.ac.uk/media/Media_736358_smxx.docx
http://healthscotland.scot/media/2875/how-to-make-an-accessible-excel-document-ms-office-2013.pdf
https://support.microsoft.com/en-us/topic/make-your-excel-documents-accessible-to-people-with-disabilities-6cc05fc5-1314-48b5-8eb3-683e49b3e593#:~:text=a%20sheet%20tab-,Use%20a%20simple%20table%20structure%2C%20and%20specify%20column%20header%20information,completely%20blank%20rows%20or%20columns.
https://support.microsoft.com/en-us/topic/make-your-excel-documents-accessible-to-people-with-disabilities-6cc05fc5-1314-48b5-8eb3-683e49b3e593#:~:text=a%20sheet%20tab-,Use%20a%20simple%20table%20structure%2C%20and%20specify%20column%20header%20information,completely%20blank%20rows%20or%20columns.
https://accessibility.psu.edu/microsoftoffice/excel/
https://www.youtube.com/watch?v=qDvTAh3shjk
https://www.youtube.com/watch?v=qDvTAh3shjk
https://www.youtube.com/watch?v=yOj1HwPGgic
https://www.youtube.com/watch?v=yOj1HwPGgic
https://www.youtube.com/watch?v=RjFeybdYEqo
https://www.youtube.com/watch?v=RjFeybdYEqo
https://www.youtube.com/watch?v=RS4YW-fcQ6U
https://www.youtube.com/watch?v=RS4YW-fcQ6U
https://www.youtube.com/watch?v=9QmlEHNFoxw
https://www.youtube.com/watch?v=9QmlEHNFoxw
https://support.microsoft.com/en-us/office/video-start-with-an-accessible-excel-template-91
https://support.microsoft.com/en-us/office/video-start-with-an-accessible-excel-template-91
https://www2.worc.ac.uk/it/documents/Guide_to_making_a_document_accessible.pdf
https://www.rnib.org.uk/sites/default/files/Creating%20accessible%20Excel%20spreadsheets.docx
https://ucop.edu/information-technology-services/_files/create-accessible-excel.pdf
https://webaim.org/resources/evaloffice
https://www.gov.uk/government/publications/doing-a-basic-accessibility-check-if-you-cant-do-a-detailed-one/doing-a-basic-accessibility-check-if-you-cant-do-a-detailed-on
https://accessibility.psu.edu/microsoftoffice/
https://abilitynet.org.uk/factsheets/creating-accessible-documents-0
https://www.kent.ac.uk/guides/accessible-content/accessible-documents
https://www.gov.uk/guidance/content-design/writing-for-gov-uk
https://www.gov.uk/guidance/content-design/writing-for-gov-uk
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• The accessibility principles are the same for a webpage as a word document. 

• Do not publish everything you can online. Publish only what someone needs to 

know, or you are legally obliged to publish. 

• Good online content is easy to read and understand. It uses short sentences, sub-

headed sections, simple vocabulary. 

 

Accessibility, usability, and inclusion are closely related aspects in creating a web site or 

Web page that works for everyone.  

Accessibility: addresses discriminatory aspects related to equivalent user experience for 

people with disabilities. Web accessibility means according to the Web Accessibility 

Initiative that people with disabilities can equally perceive, understand, navigate, and 

interact with websites and tools. It also means that they can contribute equally without 

barriers.  

Usability: is about designing products to be effective, efficient, and satisfying. Usability 

includes user experience design. This may include general aspects that impact 

everyone and do not disproportionally impact people with disabilities. Usability practice 

and research often does not sufficiently address the needs of people with disabilities. 

Inclusion: is about diversity and ensuring involvement of everyone to the greatest extent 

possible. In some regions this is also referred to as universal design and design for all. 

It addresses a broad range of issues including: accessibility for people with disabilities, 

access to and quality of hardware, software, and Internet connectivity, computer literacy 

and skills, economic situation, education, geographic location, culture, age, including 

older and younger people, and language. 

When using a website, accessibility depends on how a person's disability affects the way 

they perceive information on a page and how they navigate within and between pages. 

Elements that affect accessibility include: 

• For people who cannot see very well: the colours and the contrast between 

colours; the size of text; the choice of fonts. For people who are blind: how a 

screen reader interprets the elements on a page (for example, alt tags for 

images, and title tags for links); the inclusion of audio description for video 

content 

https://www.w3.org/WAI/fundamentals/accessibility-intro/
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• For people who cannot hear very well: how any audio content is represented 

graphically (for example, including subtitles or signing on video content) 

• For people who find a keyboard or mouse hard to use: the ease with which 

someone can navigate to parts of the page (for instance, by tabbing); auto-

completion of forms. 

• For people who find words difficult: the length of sentences and paragraphs; 

the complexity of the vocabulary; the choice of fonts and size of text; the 

availability of spelling checkers and word prediction; the opportunity to have 

text read out loud. 

Improving Web accessibility also benefits people without disabilities, for example: people 

using mobile phones, smart watches, smart TVs, and other devices with small screens, 

different input modes, etc, older people with changing abilities due to ageing, people with 

“temporary disabilities” such as a broken arm or lost glasses, people with “situational 

limitations” such as in bright sunlight or in an environment where they cannot listen to 

audio, and people using a slow Internet connection, or who have limited or expensive 

bandwidth. 

The Government Digital Service has some useful tips on the Dos and don'ts on designing 

for accessibility which is shared in this section.  

Designing for users on the autistic spectrum 

Do: use simple colours, write in plain English, use simple sentences and bullets, make 

buttons descriptive - for example, attach files, build simple and consistent layouts 

Don't: use bright contrasting colours, use figures of speech and idioms, create a wall of 

text, make buttons vague and unpredictable - for example, Click here, build complex and 

cluttered layouts 

Designing for users of screen readers 

Do: describe images and provide transcripts for video, follow a linear, logical layout, 

structure content using HTML5, build for keyboard use only, write descriptive links and 

heading - for example, Contact us 

Don't: only show information in an image or video, spread content all over a page, rely 

on text size and placement for structure, force mouse or screen use, write uninformative 

links and heading - for example, Click here 

https://www.w3.org/WAI/fundamentals/accessibility-intro/
https://accessibility.blog.gov.uk/2016/09/02/dos-and-donts-on-designing-for-accessibility/
https://accessibility.blog.gov.uk/2016/09/02/dos-and-donts-on-designing-for-accessibility/
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Designing for users with low vision 

• Do: use good contrasts and a readable font size, publish all information on web 

pages (HTML), use a combination of colour, shapes and text, follow a linear, 

logical layout -and ensure text flows and is visible when text is magnified to 200%, 

put buttons and notifications in context 

• Don't: use low colour contrasts and small font size, bury information in downloads, 

only use colour to convey meaning, spread content all over a page -and force user 

to scroll horizontally when text is magnified to 200%, separate actions from their 

context 

Designing for users with physical or motor disabilities 

• Do: make large clickable actions, give form fields space, design for keyboard or 

speech only use, design with mobile and touch screen in mind, provide shortcuts 

• Don't: demand precision, bunch interactions together, make dynamic content that 

requires a lot of mouse movement, have short time out windows, tire users with 

lots of typing and scrolling 

 

Designing for users who are D/deaf or hard of hearing 

• Do: write in plain English, use subtitles or provide transcripts for video, use a 

linear, logical layout, break up content with sub-headings, images and videos, let 

users ask for their preferred communication support when booking appointments 

• Don't: use complicated words or figures of speech, put content in audio or video 

only, make complex layouts and menus, make users read long blocks of content, 

don't make telephone the only means of contact for users 

Designing for users with dyslexia 

• Do: use images and diagrams to support text, align text to the left and keep a 

consistent layout, consider producing materials in other formats (for example, 

audio and video), keep content short, clear and simple, let users change the 

contrast between background and text 

• Don't: use large blocks of heavy text, underline words, use italics or write capitals, 

force users to remember things from previous pages - give reminders and 
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prompts, rely on accurate spelling - use autocorrect or provide suggestions, put 

too much information in one place 

Audio, and video 

Audio and Video are used on webpages to share information regularly by many 

organisations, but we need to make sure that they are accessible to everyone. 

The Web Accessibility Initiative provides helpful information some of which has been 

included in this section on how to make sure that your audio and video content is 

accessible and what to think about when developing it. 

User Experiences and Benefits to Organizations: Understand the needs of people with 

disabilities. Learn about benefits to organizations, and benefits to everyone in a variety of 

situations. 

Planning Audio and Video Media: Plan for accessibility from the very start of your project, 

to save time and money. For example, integrated description is easier and better for 

accessibility, and it needs to be included in the script before filming. 

Audio Content and Video Content: Make new audio and video content accessible. Avoid 

accessibility barriers when planning, scripting, storyboarding, and recording your media. 

Audio Description of Visual Information: Provide description so that people who are blind 

and others who cannot see the video adequately get the visual information needed to 

understand the content. This includes things like charts, graphs, and text such as 

speaker names, titles, and e-mail addresses 

Captions /Subtitles: For audio and videos you need to make sure that you provide 

captions (also called “subtitles”) so that people who are Deaf and hard-of-hearing get a 

text version of the speech and non-speech audio information needed to understand the 

content. 

Transcripts Provide a transcript, that is, a text version of the speech and non-speech 

audio information. Ideally, make it a descriptive transcript that also includes text 

description of the visual information. Descriptive transcripts are required to provide video 

content to people who are Deaf or blind. (descriptive transcript excerpt example) 

Sign Languages: Provide sign language when your audience needs it, so that Deaf 

people whose language is sign get the content in their language. 

https://www.w3.org/WAI/media/av/
https://www.w3.org/WAI/media/av/users-orgs/
https://www.w3.org/WAI/media/av/planning/
https://www.w3.org/WAI/media/av/av-content/#integrate-description
https://www.w3.org/WAI/media/av/av-content/
https://www.w3.org/WAI/media/av/description/
https://www.w3.org/WAI/media/av/captions/
https://www.w3.org/WAI/media/av/transcripts/
https://www.w3.org/WAI/media/av/transcripts/#descriptive
https://www.w3.org/WAI/media/av/sign-languages/
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Media Players: Use a media player that supports accessibility. 

Section 5: Designing Accessible Surveys 

The platform and templates used should be designed to comply with accessibility 

regulations. You must also ensure that the structure and content of your survey is 

accessible, inclusive, and effective. A well-designed survey will be easier for all 

respondents to complete, whether they have a disability or not.  

Online surveys should inform users of potential accessibility issues, who they need to 

contact for assistance and how they can access a survey that meets their needs.  

Imperial College and Smartsurvey both have useful guidance on creating accessible 

surveys some of their content is included in this section. 

Survey structure 

Use an introduction section to give your survey a clear structure and to provide helpful 

information at the start of the survey. 

Provide an indication of how long the survey will take to complete at the beginning of 

your survey and use a progress bar at the bottom of the survey. Make sure that 

questions and answer options are clear and unambiguous. Numbering your questions will 

help users now that they are following the right sequence. 

Language and text 

• Use short sentences – this helps everyone to understand the questions efficiently, 

even if they are using a screen reader. 

• Keep questions simple and to the point - make your questions easy to understand by 

using simple everyday language that people will understand. (However, if you are 

collecting data from an expert, it is OK to use jargon that they will understand, if you 

explain the jargon in the first instance.) 

• You may be tempted to format text in italic or bold for emphasis – this should be 

avoided; it is recommended that you use bold for individual words and not for whole 

sentences as it makes text harder to read.  

• Avoid using BLOCK CAPITALS - the use of All Caps can reduce the readability of your 

text because all words have a uniform rectangular shape, meaning readers cannot 

identify words by their shape and this reduces reading speed. 

https://www.w3.org/WAI/media/av/player/
https://www.imperial.ac.uk/staff/tools-and-reference/web-guide/training-and-events/materials/accessibility/surveys/
https://help.smartsurvey.co.uk/article/Choosing-Accessible-Questions?s=accessibility


Page 42 of 45 

• Avoid changing the font, font colour and font size of your question text. If you must do 

this it should be used sparingly, as deviating from the templates default may cause 

problems for users with visual impairments. A recommended minimum font size is 14 

or 16 pt. The font style recommended is Arial and should be black on a white or cream 

background. 

• Do not use icons or images without Alt text.  

• Do not use images or colours to convey information alone, ensure there is text to 

explain the use of the images. 

• If you need to present a large amount of text in a question, break it up into a bulleted 

list. 

• Your survey platform / software used must be compatible with screen reader software. 

• If you need to present a large amount of text in a question, break it up into a bulleted 

list. 

• If you use headings within the survey text, ensure they are accessible.  

• If you are using links within the survey text, ensure they are accessible. 

• It should be possible to complete the survey without the use of a mouse. Respondents 

should be able to tab between questions and submit surveys using only keyboard 

input. 

Layout and Design:  

It is also important to consider how accessible the layout and design of your survey is on 

different equipment and in different formats, what works on paper may not work online, 

what works on a laptop or PC may not work on a mobile phone or tablet or may not be 

compatible with assistive technology such as screen readers or magnifiers. 

• Consider how many questions on a page, too many and it will become 

inaccessible for some and reduce the number of people willing to complete them. 

You would need to consider reducing the number of questions or splitting them 

between pages.  

• Consider how long it takes to complete the survey and whether this may reduce 

accessibility. 

Question layout: It is important to consider the way a question is laid out to ensure that 

all users can respond to the question easily. Some questions layouts are not accessible 

and should be avoided. Imperial College Below are some common layouts that are used 

and some advice on when and when not to use them. 

https://www.imperial.ac.uk/staff/tools-and-reference/web-guide/training-and-events/materials/accessibility/headings/
https://www.imperial.ac.uk/staff/tools-and-reference/web-guide/training-and-events/materials/accessibility/links/
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Multiple choice questions: You can choose to present multiple-choice answer options 

horizontally or vertically. For a simple ‘yes/no’ question, a horizontal format might work 

well. However, if you offer several possible answer options, it is often easier for 

respondents with a visual impairment to read the different options if they are arranged 

vertically. 

Example below of a vertical multiple-choice question which is recommended: 

 

Scales: If you are using a numeric scale which is only defined in the question text, then a 

user with a short-term memory impairment may not be able to remember what the 

options relate to. They will have to keep referring to the scale for each question. 

It is better to avoid using a separate scale. Instead use explicit wording for each answer. 

For example: Very good, good, Neither good or bad, bad, very bad. The user would then 

be reminded of the possible responses separately for each question as shown below 

 

Question grids: Grid questions or scale/rank questions are often used to group similar 

questions together with the intention of avoiding repetition and allowing respondents to 

progress through the survey quickly. For example: 
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Grids can result in long, complicated layouts and may not be optimised for mobile 

devices. This means they pose significant barriers for all users. To make your survey as 

accessible as possible, it is recommended that you should limit or avoid the use of grid 

and scale/rank questions. If you do have to use this type of question, ensure the vertical 

and horizontal questions/answers are kept to a minimum. 

Dropdown Menus: If a question requires participants to select from a number of options, 

use check boxes or the circular radio buttons used in multiple choice questions rather 

than drop down lists as they present the options in a more convenient and accessible 

manner. 

Sliding Scale: Some forms of sliding scale questions may not be accessible for all users. 

Images, audio, and video: When using images, audio, and video in surveys, you should 

provide a text equivalent for this content. When inserting an image, you will need to enter 

alternative text in the dialogue box. For other media (audio or video) you should include a 

separate transcript or caption in the associated note or question text. 

Smartsurvey and Accessible Questions 

Smartsurvey provides a guide on choosing accessible questions which should be 

followed when using this software. 

✓ Inaccessible question types to avoid: Do not use: Matrix of choices with 

Checkboxes, Ranking, Continuous sum, Slider or Semantic Differential. 

✓ Enable question numbers: Keep question numbers on to enable respondents to 

keep track of questions. 

✓ Keep label text short: When appropriate, make the first word or words 

meaningful to the user. Providing short labels should be balanced with tone of 

voice. An example of this is shown below in Figure1: 

Figure 1: Accessible style of user details question 

 

https://help.smartsurvey.co.uk/article/multiple-choice-questions-with-one-answer
https://help.smartsurvey.co.uk/article/Choosing-Accessible-Questions?s=accessibility
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✓ Predefined options: Where possible use multiple choice to reduce amount of text 

entry needed. 

 

✓ Use plain language and explain any specialist terms. 

 

✓ N/A is often used as an option: Not everyone knows what N/A stands for. Is it no 

answer or not applicable? For maximum accessibility, use the full word instead of 

the acronym or provide an explanation at the beginning of the survey. 

Not applicable and no answer mean different things to different people. You may have 

to change the wording depending on the question and its context. Would ‘prefer not to 

say’ or ‘does not apply to me’ be more useful? 

✓ Use single or multiple-choice questions: Text boxes and dropdown menus 

require more effort from the user so avoid these. For Multiple choice (Only one 

answer and multiple answers) use a vertical layout where appropriate. Vertical 

layouts are easy to scan read especially for screen magnifier users. 

✓ Accessible Likert scales: Don't hide instructions or key explanations in blocks of 

text. Chunk text and use bullet lists for easier scanning. 

Example: 

Do: Select how much you agree with the following statements using this scale: 

1 = do not agree at all 

10 = completely agree. 

Don’t: Your feedback is important to us and will be used to improve our service to 

you and all our customers. On a scale of 1 to 10 (where 1 is do not agree and 10 

is completely agree) how much do you agree with the following statements? 

✓ Matrix of Choices: Use single multiple-choice questions instead of the matrix of 

choices. This question format is partially accessible but there are issues for screen 

reader users who use NVDA screen reader with Chrome browser. 

Avoid using matrixes of checkboxes as these are not available for NVDA screen 

reader users who use Chrome browser. If using this question type, chunk 

statements into sections so users aren't overwhelmed. For example, use no more 

than 4 statements per matrix. 
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